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iThesis NexGen is a digital platform for managing academic
documents, theses, and research papers. It elevates document
management into a fully digital system, supporting university
workflows such as online submission and approval, plagiarism

detection, and AI-powered analysis.

What is iThesis NexGen?

This platform reduces complex procedures, increases accuracy 
in document handling, supports collaborative work, and ensures

that academic processes are faster and more efficient.
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Summary of Key Processes 
in the iThesis System for Students

1.  Receive Invite Email - Access the system via the invitation email from the  
        institution. Prepare Microsoft Word with the iThesis installed.

2.  Enter Required Information - Fill in essential details in the thesis template, 
        including committee member names.

3.  Prepare Thesis Document - Draft, review, and save the thesis document into
       the system.

4.  Plagiarism Check - Perform plagiarism detection before submitting a 
        request for approval, following the institution’s process.

5.  Complete Submission Form and Publication - Enter submission details 
       and publication information as required.
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When starting to use the system, students, advisors, and committee members will receive an
invitation email from the institution to access iThesis NexGen.

Invitation Email

The email includes:
A welcome message introducing iThesis NexGen as a one-stop platform for thesis and
research management.
An invitation link: Join iThesis NexGen.
A quick start guide for new users.

Step 1 : Click Join iThesis NexGen to accept the invitation.

Step 2 : Register for a NexGen Account to begin 
using the system. You may connect using:

Google Account
Microsoft Account
Email Address

By continuing, users agree to the Privacy Policy.

Step 3 : The system will request confirmation
to link student information with your account.
This ensures that your NexGen account is
properly connected to your institutional data
for thesis management.
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The NexGen Account is a centralized, multi-tenant user account system that allows users to
access all features of iThesis NexGen across devices and platforms, including:
            iThesis                NexGen Website          NexGen Mobile App

Student Functions

NexGen Account

Tracking - NexGen Mobile App
Students can track approval progress,
plagiarism detection results, AI-assisted
writing, and important announcements directly
from the mobile app. Submitting - iThesis NexGen Web Portal

Submit proposals and final thesis documents.
Display approval status.
Send and receive Review and Feedback
messages through the portal.

Writing - iThesis Word Add-in (Windows/macOS)
Write thesis documents.
Perform plagiarism checks.
Use Co-Creation with AI for enhanced writing support.
Integrate with Mendeley for reference management.

Additional Notes
Students must have access to Office 365 or Microsoft 365   
to use Microsoft Word with iThesis.
Relevant files (Word and PDF) are required for submission.
The system records revision history, plagiarism detection
results, and committee feedback.
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Microsoft Word Compatibility
To check the version of Microsoft Word:

Go to File > Account > Product Information.

Writing with iThesis Add-in

The iThesis can be used on both Windows and macOS platforms that support 
the desktop version of Microsoft Word.

It is recommended to update your version to the latest release:
Click Update Options > Update Now.

Supported Microsoft Office Versions:
Microsoft 365
Office 2021
Office 2021 LTSC
Office 2019 (Retail Version)
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To install the iThesis in Microsoft Word:

Installing iThesis Add-in

Notes
In some versions of Microsoft Word, the Add-in may appear under
the Home or Insert menu.
Look for the Add-ins icon to access the iThesis NexGen.

1.  Go to File > Get Add-ins.
2. Type “iThesis NexGen” in the search box.
3.  Click Add.
4.  Click Continue to complete the installation.

iThesis Nex-Gen, Rover AI and Ecosystem were developed by Facgure Company Limited and its subsidiary. All Rights Reserved.



On the first use of the iThesis:
Press OK > Next > Get Started (this section appears only during the initial setup).

Getting Started with iThesis Add-in

Functions Available
Generate Template - Create a ready-to-use thesis document template with the
required format and structure.
Write Contents - Begin writing the thesis directly in the template.
Save to Cloud - Upload the file to the web portal to keep it updated and create
revisions.
Cite Articles - Manage references and citations within the document.
Check Plagiarism - Verify originality of the thesis content.
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iThesis NexGen Mobile Application

Note: Use the same login account as the website app.ithesis.co.

Login to iThesis Add-in via Mobile App

The mobile application allows users to log in conveniently, including via QR Code scanning.

Steps:
1.  Download the iThesis NexGen Mobile App from the App Store or Google Play.

2.  Scan the QR Code to log in.
3.  Access features such as plagiarism detection, revision tracking, and notifications.
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For NexGen users, login options include:
      Gmail        Microsoft       Apple ID        Email



This interface allows students to manage their thesis workflow, from template
generation to submission and approval tracking.

Note: Use the same login account as the website app.ithesis.co.

For NexGen users, login can also be performed using Email and Password.
Steps:

1.  Enter your Email Address.        3. Press Login to access the system.   
    2. Enter your Password.               4. If necessary, use the Forgot Password 
                                                                 option to reset your credentials.

Login to iThesis Add-in via Email / Password

iThesis NexGen interface after login, showing available functions such as:
Generate Template
Validate Template
Revision & Feedback
Draft, Update Progress, Complete
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By setting the correct margins and paper size, students ensure that their
thesis document complies with institutional formatting standards 

before generating the template with the iThesis.

Creating and Formatting Thesis Documents
with Microsoft Word

Step 2 : Set the paper size to A4 (8.27" x 11.69").

Starting Thesis Document Creation via iThesis
Step 1 : Set the margins according to the required format.

Left: 1.5 inches (3.81 cm)
Top: 1.5 inches (3.81 cm)
Right: 1 inch (2.54 cm)
Bottom: 1 inch (2.54 cm)
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Step:
Press Generate.
Select the thesis language (Thai or English) - this step is required only during the first use.
Press Confirm to proceed.

If you press Generate without setting the correct paper size and margins, the system
will display a warning message:

Please adjust the paper size and margin before generate template.

The document template is set to A4 paper with specific margins. Please follow these instructions
before generating the template:

Creating and Formatting Thesis Documents
with Microsoft Word (continued)

1.  Go to Layout.
2. Change the paper size to A4.

3.  Adjust the margins as follows:
Left: 1.5 inches (3.81 cm)
Top: 1.5 inches (3.81 cm)
Right: 1 inch (2.54 cm)
Bottom: 1 inch (2.54 cm)
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Entering Data into the Generated Thesis
Template

Notes
Editable fields allow students to input thesis information such as title, abstract,
and acknowledgements.
Non-editable fields (gray boxes) are reserved for system-generated content,
such as institutional details and standardized formatting.
Synchronization between the Word document and the iThesis Web Portal ensures
consistency of thesis data before submission.

When working with the thesis template created by the iThesis:
Green text boxes: Editable. You can type directly into these fields.
Orange text boxes: Editable once you begin typing (the color change
occurs only when the Add-in is active).
Gray text boxes: Non-editable. These fields are automatically
generated by the system and cannot be modified.
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For documents requiring advisor and committee information, names must be added 
via the Form menu in the iThesis. Instructions can be found in the section 

“Adding Committee Members.”

Certain sections in the thesis document are directly linked with the iThesis system. These sections can be
edited and updated to synchronize with the system. It is necessary to ensure that the information in the

document matches the data stored in the system before saving the file to the cloud.

Data in the Thesis Document Linked with the
iThesis System

Important Notes
If data is edited but not updated, the system will prevent saving and display a warning screen.
Equations created using Microsoft Word’s Equation tool cannot be inserted or saved in linked text boxes.
Some symbols may display differently depending on the selected font and database compatibility.

Cover Page - Thesis title in Thai and English.
Abstract - Keywords and abstract content.
Acknowledgement - Acknowledgement text.
Vita - Author biography following the institution’s format.

The linked sections include:
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Note: 
This process does not yet save the file into the system; it only updates the data fields.

Data can be updated by clicking on the orange text box and then pressing
the Update button. Once the update is successfully saved,

the text box will change to green.

Updating Data to the System via iThesis Add-in

Update Process
This process updates data section by section.
If you want to update all data at once, press Validate Template to check
and update the information.
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In the thesis template, the area to begin writing content is marked with the
phrase “Start writing Chapter 1 here.”

Start Writing/Placing Content 
in the Thesis Document

Turn on Paragraph Marks to view Section Breaks clearly.
You may paste content prepared in other files into this section, or start
typing directly here.
Be careful not to delete the Section Breaks, as they are essential for
maintaining the correct document structure.

The thesis content, including chapters and the table of contents, can be written and
formatted using standard Microsoft Word functions.
The document can be used together with a Reference Manager program for
citations and bibliography management.
It is recommended to use Mendeley Cite for managing references efficiently.

Writing and Formatting Content
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To add examination committee members:

Adding Committee Members

1.  Go to Form > Add Committee & Examiner.
2.  Select Committee Type (e.g., Advisor, Co-Advisor, Chairman, Dean, Committee, External Examiner).
3.  Type the professor’s name and select from the list displayed.
4.  Save the information.

iThesis interface showing the Committee & Examiner form. Options include selecting committee type,
searching for names, and saving details.
Examples of committee roles:

The system requires entering at least three characters to search for names.

Co-Advisor
Chairman
Dean
Committee
External Examiner

Important Note:
Committee names can only be selected from those already
available in the system.
If a name is not found, contact the institution’s system
administrator to add the committee member.
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Adding Committee Members (continued)

iThesis interface showing options to add prefix and postfix names for committee members.
Examples include:

Prefix Name: Asst. Prof. Dr. 
Postfix Name: Ph.D., R.R., L.A.R.

Students can add prefix names (e.g., academic titles) and postfix names (e.g., honorifics) for
committee members by following these steps:

1.  Click Add Data.   2. Select the prefix or postfix you wish to add.   3. Press Add to confirm.

After adjusting the name format:
Scroll down and press Save to record the committee member’s details.
Add other committee members using the same method until the list is complete.

Note: 
Once committee names are updated, students must press Generate Template to ensure
that the updated names appear correctly in the thesis document.
Icons are available to edit or delete committee member information if needed.
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Committee information can also be added directly through the iThesis Web Portal. 
The required details include:

Name of the committee member
Position/role (e.g., Advisor, Chairman, Dean, Committee, External Examiner)
Prefix and Postfix (academic titles or honorifics)

Note:
After entering the required information, press Save to store the committee member’s details.
Repeat the process to add all required committee members.
Prefix and postfix names ensure proper formatting of academic titles in both Thai and English.

Adding Committee Members via the Website

The form for adding committee members, showing fields for:
Committee type (e.g., Chairman)
Committee or examiner name (e.g., Sasithorn Boonwat)
Prefix and Postfix options (e.g., Dr., Asst. Prof., Ph.D.)
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Validating Data in the Thesis Document
(Validate Template)

To ensure that the thesis document matches the data stored in the iThesis system:
1.  Press Validate Template.

2. If there are discrepancies, the system will display a message in Validate Results.
3. Review the issues and press Update to synchronize the data.

You can press Update All to update all mismatched data in the document to the system at once.
After pressing Update All, press Update again and wait for the system to complete
synchronization.

If the document data matches the system data, the following message will appear at the bottom of the
iThesis screen:

Validate template successfully. No lost content from your thesis template.

This indicates that the document can now be saved to the system (Save to Cloud).

Updating All Data

Successful Validation
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To save the thesis document into the iThesis system:
1.  Press Save to Cloud.

2. Wait for the process to complete (this may take longer if the file size is large).
3.  A preview screen will appear showing the document data.
4.  Press Save to confirm.

The Save to Cloud preview window showing thesis metadata fields such as:
Cover Page - Thesis topic in Thai and English.
Abstract - Keywords and abstract content in Thai and English.
Acknowledgement - Acknowledgement text.

The system requires reviewing and updating the Table of Contents (TOCs) before saving.

Note:
Once the file is successfully saved, it will appear in the Revision & Feedback section.
The system may display a progress message such as:

          Save to Cloud in progress. It might take a few minutes. Please stay on this page until it finishes.
The saved file will be timestamped and listed with its size in kilobytes (KB).

Saving the File to the System (Save to Cloud)
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Important Note:
Files saved to the system are not automatically sent to the advisor.
Students must submit a request through the iThesis Web Portal for advisor review and approval.

PDF File Verification
The system generates a PDF version of the thesis document with a barcode indicating the file version.
This PDF is the version that advisors will receive when students submit for approval.
Students should carefully review the generated PDF before sending the request to the advisor.
If corrections are needed, make changes in the Word document and then press Save to Cloud again to update.

Reviewing Saved Files
After saving the thesis document to the system, you can review it under the 

Revision & Feedback section.

To open a saved file, follow these steps:
   1. Click on the saved file entry.

2.  Press PDF.
3.  Press Open File to view the generated PDF.
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A pending approval message:
You have requested to edit the topic of this proposal. The request is awaiting approval from the

relevant parties. You can track the approval progress in the Timeline.

Step 3 : If university policy requires approval, the system will display a Pending Approval status. 
The topic will be updated only after approval is granted.

Revising and Requesting Approval 
for Thesis Topic (Revise Topic)

Students may revise their thesis topic if permitted by the university. The process is as follows:

Step 1 : Select the current topic to update. 

Topic revision requests must follow the institution’s approval workflow.
Students can track the approval progress in the Timeline section.
Once approved, the new topic will replace the old one in the system.

Note:

Step 2 : Enter the new topic name in both English and
Thai (or alternative language) and press Save to request
approval. 

Topic revision form with fields for:
Current Topic (ENG/ALT)
New Topic (ENG/ALT)
Options to Cancel or Save
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Updating Thesis Topic (Revise Topic)
in iThesis Add-in

Once the request to revise the thesis topic has been approved by the university, students must:

Note:
The Retrieve function ensures that the thesis document reflects the latest approved topic from
the iThesis Web Portal.

Students should be aware that formatting styles may change after retrieval.
After updating, the thesis document can be saved again to the cloud for further processing.

A confirmation dialog appears:
Are you sure you want to Retrieve? Retrieve will replace your content with 

the latest content from the web portal. However, the style might change 
from the current view.

1.  Log in to the iThesis.
2. Press Retrieve to update the thesis topic with the newly approved title.

iThesis Nex-Gen, Rover AI and Ecosystem were developed by Facgure Company Limited and its subsidiary. All Rights Reserved.



Plagiarism Check via iThesis Add-in

Before submitting a request to the advisor, students must perform a Plagiarism Check. 
In the iThesis system, the first step is to check using the Akkharavisuthi service 
(Thai plagiarism detection).

Reviewing the Report
Once the check is complete, click on the result to open the plagiarism report generated by the system.
The report provides detailed analysis of similarity percentages and sources.
Students must review the report carefully before proceeding to submit their thesis for advisor approval.

Steps:
1.  Click on the saved file entry.             

   2. Press Check.
3.  Select the plagiarism detection service (e.g., Akkharavisuthi, Copyleaks,  

        PlagiarismCheck.org).
4.  Wait until the system completes the plagiarism check.
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Submitting a Proposal Request 
for Approval

Status After Submission
Once the proposal is submitted, the status will change to 
Waiting for Proposal Approval.

Step-by-step process:
1.  Select the Revision & Feedback menu.

2.  Choose the document (Revision) from Save to Cloud that you wish to submit
        for approval.

3.  Review the information and press Submit Proposal.
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Status After Approval
When all approvers have approved, the status will change to Approved.



Submitting a Proposal Request 
for Approval

The system displays:
Proposal Status: Waiting for Approval
Plagiarism Detection Result: 4.64%
Committee Members: Advisor, Chairman, Committee, Dean
Relevant Files:

Word file for editing and review (document.docx, 52.87 KB)
PDF file for final approval (document.pdf, 298.53 KB
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At the bottom of the screen,
committee members can

press Approve or Disapprove 
after reviewing the files. 

The system also records the
latest revision time.

Relevant Files are the documents associated with the thesis approval request. These include:
1.  Word File - Used for editing or for committee review.

2.  PDF File - The complete version used for final approval.

Committee members can download these files for review and then press Approve or Disapprove
as appropriate. The system will display the latest file update time to ensure 

that the committee is reviewing the most recent version.



Submitting the Final Thesis 
(Complete Submission)

When the thesis reaches the final approval stage, it proceeds to the Complete Submission process.
This step is used for submitting the final version of the thesis for approval and verification. 
The main structure includes:
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01 Complete Your Submission Form
The user must fill out and submit the submission form by clicking “Go to submission menu” 

       to enter the required information.
Once completed, the system will generate a Submission Document.

02 Committee & Files
Committee: Includes advisor and examination committee members.
Displays the list of committee members and their approval status.
The “Ready For Submission” button will remain disabled until all committee members have approved.
Relevant Files: The list of thesis files required for submission and review.



04 Thesis Verification (Final File Check)
Once approved by all parties and verified, the thesis will be published as the 

       Final Document.

03 Graduate Staff Approval
The thesis will be forwarded to the Graduate School Officer for review and approval.

Submitting the Final Thesis 
(Complete Submission) (Continued)
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The system displays:
Submission Form: Required details for submission.
Committee & Files: Committee approval status and required files.
Graduate Staff Approval: Pending graduate officer review.
Thesis Verification: Final thesis file prepared for publication.



1. Evaluation & Dissemination
Committee members can select the evaluation result of the thesis (e.g., Very Good,
Good, Passed, Not Passed).
Dissemination through electronic media, publications, radio, and television can be
specified.
If Allowed, the thesis details and PDF file will be published in the institute’s intellectual
repository.
Only the PDF file will be sent to the Thai Digital Collection (TDC), which is used as the
plagiarism-checking database.
If Not Allowed, the thesis will not be disseminated publicly.

Submitting the Final Thesis - Submission Form

The Submission Form is the form used to enter information before submitting 
the final thesis. It consists of the following key sections:
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3. Research Mapping
Subject Area / Subject Category: The user must select the subject area or category of 

      the thesis.
Research Projects: Select the related research topic.
Thailand Standard Industrial Classification (TSIC) and International Standard
Classification of Education (ISCED): Choose the thesis type according to industrial and
educational standards.

Submitting the Final Thesis - Submission Form
(continued)

2. Dissemination of Full Document on a Website
If Allowed, the thesis details and PDF file will be published in the institute’s repository.
Only the PDF file will be sent to TDC for plagiarism detection.
If Not Allowed, the thesis will not be disseminated online.
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4. Save Information
Press Save to record the information and generate the Submission Document.



Submitting the Final Thesis 
(Complete Submission)

The Published Version with the institution’s watermark is the officially approved
thesis file.
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This file is the final published version of the thesis.
It contains the watermark of the university to certify authenticity.
It is usually in PDF format and cannot be edited.
Additional requirements may vary depending on the university and may be subject
to change.
If there are any questions, students should contact the institution’s staff.

Relevant files are the documents associated with the final thesis submission.
These include the Word file for editing and the PDF file for final approval.



Key functions include:
1.  Real-time Tracking - Monitor the approval status in real time through the tracking

timeline.
2.  Feedback Review - Check comments and suggestions from advisors and committee

members.
3.  Notifications - Receive alerts via mobile app and email whenever there is an

update in status.

Users can also receive notifications through the iThesis NexGen Mobile App, 
available on both iOS and Android.

Status Tracking
The Tracking Timeline + Notification feature helps both authors and mentors work together
more efficiently, reducing delays in the approval process.
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The mobile application can be downloaded from:  Google Play (Android)App Store (iOS)



Summary of Key Processes in
the iThesis System for Students
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Complete Submission Form and Publication - Fill out the submission form 
and publication details for the final approval process.

5.

1. Receive Invite Email - Access the system via the institution’s email invitation.
Prepare Microsoft Word and install the iThesis.

2. Enter Required Information - Fill in essential details according to the thesis
template, including committee member names.

3. Prepare Thesis Document - Draft the thesis, validate, and save it into the system.

4. Plagiarism Check and Proposal Submission - Perform plagiarism detection and
submit the proposal request for approval according to institutional procedures.
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	The mobile application allows users to log in conveniently, including via QR Code scanning.
	Steps:
	Download the iThesis NexGen Mobile App from the App Store or Google Play.
	Scan the QR Code to log in.
	Access features such as plagiarism detection, revision tracking, and notifications.


	Login to iThesis Add-in via Email / Password
	For NexGen users, login can also be performed using Email and Password. Steps:
	Enter your Email Address.        3. Press Login to access the system.
	2. Enter your Password.               4. If necessary, use the Forgot Password                                                                   option to reset your credentials.
	Note: Use the same login account as the website app.ithesis.co.
	iThesis NexGen interface after login, showing available functions such as:
	Generate Template
	Validate Template
	Revision & Feedback
	Draft, Update Progress, Complete
	This interface allows students to manage their thesis workflow, from template generation to submission and approval tracking.

	Creating and Formatting Thesis Documents with Microsoft Word
	Starting Thesis Document Creation via iThesis
	Step 1 : Set the margins according to the required format.
	Left: 1.5 inches (3.81 cm)
	Top: 1.5 inches (3.81 cm)
	Right: 1 inch (2.54 cm)
	Bottom: 1 inch (2.54 cm)
	Step 2 : Set the paper size to A4 (8.27" x 11.69").
	By setting the correct margins and paper size, students ensure that their thesis document complies with institutional formatting standards  before generating the template with the iThesis.


	Creating and Formatting Thesis Documents with Microsoft Word (continued)
	If you press Generate without setting the correct paper size and margins, the system will display a warning message:
	Please adjust the paper size and margin before generate template.
	The document template is set to A4 paper with specific margins. Please follow these instructions before generating the template:
	Go to Layout.
	Change the paper size to A4.
	Adjust the margins as follows:
	Left: 1.5 inches (3.81 cm)
	Top: 1.5 inches (3.81 cm)
	Right: 1 inch (2.54 cm)
	Bottom: 1 inch (2.54 cm)
	Step:
	Press Generate.
	Select the thesis language (Thai or English) - this step is required only during the first use.
	Press Confirm to proceed.


	Entering Data into the Generated Thesis Template
	When working with the thesis template created by the iThesis:
	Green text boxes: Editable. You can type directly into these fields.
	Orange text boxes: Editable once you begin typing (the color change occurs only when the Add-in is active).
	Gray text boxes: Non-editable. These fields are automatically generated by the system and cannot be modified.
	Notes
	Editable fields allow students to input thesis information such as title, abstract,   and acknowledgements.
	Non-editable fields (gray boxes) are reserved for system-generated content,        such as institutional details and standardized formatting.
	Synchronization between the Word document and the iThesis Web Portal ensures consistency of thesis data before submission.


	Data in the Thesis Document Linked with the iThesis System
	Certain sections in the thesis document are directly linked with the iThesis system. These sections can be edited and updated to synchronize with the system. It is necessary to ensure that the information in the document matches the data stored in the system before saving the file to the cloud.
	The linked sections include:
	Cover Page - Thesis title in Thai and English.
	Abstract - Keywords and abstract content.
	Acknowledgement - Acknowledgement text.
	Vita - Author biography following the institution’s format.
	For documents requiring advisor and committee information, names must be added  via the Form menu in the iThesis. Instructions can be found in the section  “Adding Committee Members.”

	Important Notes
	If data is edited but not updated, the system will prevent saving and display a warning screen.
	Equations created using Microsoft Word’s Equation tool cannot be inserted or saved in linked text boxes.
	Some symbols may display differently depending on the selected font and database compatibility.
	Update Process


	Start Writing/Placing Content  in the Thesis Document
	In the thesis template, the area to begin writing content is marked with the phrase “Start writing Chapter 1 here.”
	Turn on Paragraph Marks to view Section Breaks clearly.
	You may paste content prepared in other files into this section, or start typing directly here.
	Be careful not to delete the Section Breaks, as they are essential for maintaining the correct document structure.
	Writing and Formatting Content
	The thesis content, including chapters and the table of contents, can be written and formatted using standard Microsoft Word functions.
	The document can be used together with a Reference Manager program for citations and bibliography management.
	It is recommended to use Mendeley Cite for managing references efficiently.


	Adding Committee Members
	To add examination committee members:
	Go to Form > Add Committee & Examiner.
	Select Committee Type (e.g., Advisor, Co-Advisor, Chairman, Dean, Committee, External Examiner).
	Type the professor’s name and select from the list displayed.
	Save the information.
	iThesis interface showing the Committee & Examiner form. Options include selecting committee type, searching for names, and saving details. Examples of committee roles:

	Important Note:
	Committee names can only be selected from those already available in the system.
	If a name is not found, contact the institution’s system administrator to add the committee member.
	Co-Advisor
	Chairman
	Dean
	Committee
	External Examiner
	The system requires entering at least three characters to search for names.


	Adding Committee Members via the Website
	Committee information can also be added directly through the iThesis Web Portal.  The required details include:
	Name of the committee member
	Position/role (e.g., Advisor, Chairman, Dean, Committee, External Examiner)
	Prefix and Postfix (academic titles or honorifics)
	The form for adding committee members, showing fields for:
	Committee type (e.g., Chairman)
	Committee or examiner name (e.g., Sasithorn Boonwat)
	Prefix and Postfix options (e.g., Dr., Asst. Prof., Ph.D.)
	Note:
	After entering the required information, press Save to store the committee member’s details.
	Repeat the process to add all required committee members.
	Prefix and postfix names ensure proper formatting of academic titles in both Thai and English.



	Validating Data in the Thesis Document (Validate Template)
	To ensure that the thesis document matches the data stored in the iThesis system:
	Press Validate Template.
	If there are discrepancies, the system will display a message in Validate Results.
	Review the issues and press Update to synchronize the data.
	Updating All Data
	You can press Update All to update all mismatched data in the document to the system at once.
	After pressing Update All, press Update again and wait for the system to complete synchronization.

	Successful Validation
	If the document data matches the system data, the following message will appear at the bottom of the iThesis screen:
	Validate template successfully. No lost content from your thesis template.
	This indicates that the document can now be saved to the system (Save to Cloud).


	Saving the File to the System (Save to Cloud)
	To save the thesis document into the iThesis system:
	Press Save to Cloud.
	Wait for the process to complete (this may take longer if the file size is large).
	A preview screen will appear showing the document data.
	Press Save to confirm.

	The Save to Cloud preview window showing thesis metadata fields such as:
	Cover Page - Thesis topic in Thai and English.
	Abstract - Keywords and abstract content in Thai and English.
	Acknowledgement - Acknowledgement text.
	The system requires reviewing and updating the Table of Contents (TOCs) before saving.
	Note:
	Once the file is successfully saved, it will appear in the Revision & Feedback section.
	The system may display a progress message such as:
	Save to Cloud in progress. It might take a few minutes. Please stay on this page until it finishes.

	The saved file will be timestamped and listed with its size in kilobytes (KB).



	Reviewing Saved Files
	After saving the thesis document to the system, you can review it under the  Revision & Feedback section.
	Important Note:
	Files saved to the system are not automatically sent to the advisor.
	Students must submit a request through the iThesis Web Portal for advisor review and approval.
	To open a saved file, follow these steps:    1. Click on the saved file entry.
	Press PDF.
	Press Open File to view the generated PDF.

	PDF File Verification
	The system generates a PDF version of the thesis document with a barcode indicating the file version.
	This PDF is the version that advisors will receive when students submit for approval.
	Students should carefully review the generated PDF before sending the request to the advisor.
	If corrections are needed, make changes in the Word document and then press Save to Cloud again to update.


	Revising and Requesting Approval  for Thesis Topic (Revise Topic)
	Students may revise their thesis topic if permitted by the university. The process is as follows:
	Step 1 : Select the current topic to update.
	Step 2 : Enter the new topic name in both English and Thai (or alternative language) and press Save to request approval.
	Topic revision form with fields for:
	Current Topic (ENG/ALT)
	New Topic (ENG/ALT)
	Options to Cancel or Save
	Step 3 : If university policy requires approval, the system will display a Pending Approval status.  The topic will be updated only after approval is granted.
	A pending approval message: You have requested to edit the topic of this proposal. The request is awaiting approval from the relevant parties. You can track the approval progress in the Timeline.


	Note:
	Topic revision requests must follow the institution’s approval workflow.
	Students can track the approval progress in the Timeline section.
	Once approved, the new topic will replace the old one in the system.


	Updating Thesis Topic (Revise Topic) in iThesis Add-in
	Once the request to revise the thesis topic has been approved by the university, students must:
	Log in to the iThesis.
	Press Retrieve to update the thesis topic with the newly approved title.
	A confirmation dialog appears: Are you sure you want to Retrieve? Retrieve will replace your content with  the latest content from the web portal. However, the style might change  from the current view.
	Note: The Retrieve function ensures that the thesis document reflects the latest approved topic from the iThesis Web Portal.
	Students should be aware that formatting styles may change after retrieval.
	After updating, the thesis document can be saved again to the cloud for further processing.

	Plagiarism Check via iThesis Add-in
	Before submitting a request to the advisor, students must perform a Plagiarism Check.  In the iThesis system, the first step is to check using the Akkharavisuthi service  (Thai plagiarism detection).
	Steps:
	Click on the saved file entry.
	2. Press Check.
	Select the plagiarism detection service (e.g., Akkharavisuthi, Copyleaks,
	PlagiarismCheck.org).
	Wait until the system completes the plagiarism check.
	Reviewing the Report
	Once the check is complete, click on the result to open the plagiarism report generated by the system.
	The report provides detailed analysis of similarity percentages and sources.
	Students must review the report carefully before proceeding to submit their thesis for advisor approval.



	Submitting a Proposal Request  for Approval
	Step-by-step process:
	Select the Revision & Feedback menu.
	Choose the document (Revision) from Save to Cloud that you wish to submit
	for approval.
	Review the information and press Submit Proposal.
	Status After Submission Once the proposal is submitted, the status will change to  Waiting for Proposal Approval.
	Status After Approval When all approvers have approved, the status will change to Approved.


	Submitting a Proposal Request  for Approval
	Relevant Files are the documents associated with the thesis approval request. These include:
	Word File - Used for editing or for committee review.
	PDF File - The complete version used for final approval.
	Committee members can download these files for review and then press Approve or Disapprove as appropriate. The system will display the latest file update time to ensure  that the committee is reviewing the most recent version.
	At the bottom of the screen, committee members can press Approve or Disapprove  after reviewing the files.  The system also records the latest revision time.
	The system displays:
	Proposal Status: Waiting for Approval
	Plagiarism Detection Result: 4.64%
	Committee Members: Advisor, Chairman, Committee, Dean
	Relevant Files:
	Word file for editing and review (document.docx, 52.87 KB)
	PDF file for final approval (document.pdf, 298.53 KB


	Submitting the Final Thesis  (Complete Submission)
	When the thesis reaches the final approval stage, it proceeds to the Complete Submission process. This step is used for submitting the final version of the thesis for approval and verification.  The main structure includes:
	01 Complete Your Submission Form
	The user must fill out and submit the submission form by clicking “Go to submission menu”
	to enter the required information.
	Once completed, the system will generate a Submission Document.

	02 Committee & Files
	Committee: Includes advisor and examination committee members.
	Displays the list of committee members and their approval status.
	The “Ready For Submission” button will remain disabled until all committee members have approved.

	Relevant Files: The list of thesis files required for submission and review.


	Submitting the Final Thesis  (Complete Submission) (Continued)
	03 Graduate Staff Approval
	The thesis will be forwarded to the Graduate School Officer for review and approval.

	04 Thesis Verification (Final File Check)
	Once approved by all parties and verified, the thesis will be published as the

	Final Document.
	The system displays:
	Submission Form: Required details for submission.
	Committee & Files: Committee approval status and required files.
	Graduate Staff Approval: Pending graduate officer review.
	Thesis Verification: Final thesis file prepared for publication.


	Submitting the Final Thesis - Submission Form
	The Submission Form is the form used to enter information before submitting  the final thesis. It consists of the following key sections:
	1. Evaluation & Dissemination
	Committee members can select the evaluation result of the thesis (e.g., Very Good,  Good, Passed, Not Passed).
	Dissemination through electronic media, publications, radio, and television can be specified.
	If Allowed, the thesis details and PDF file will be published in the institute’s intellectual repository.
	Only the PDF file will be sent to the Thai Digital Collection (TDC), which is used as the plagiarism-checking database.
	If Not Allowed, the thesis will not be disseminated publicly.


	Submitting the Final Thesis - Submission Form (continued)
	2. Dissemination of Full Document on a Website
	If Allowed, the thesis details and PDF file will be published in the institute’s repository.
	Only the PDF file will be sent to TDC for plagiarism detection.
	If Not Allowed, the thesis will not be disseminated online.

	3. Research Mapping
	Subject Area / Subject Category: The user must select the subject area or category of
	the thesis.
	Research Projects: Select the related research topic.
	Thailand Standard Industrial Classification (TSIC) and International Standard Classification of Education (ISCED): Choose the thesis type according to industrial and educational standards.

	4. Save Information
	Press Save to record the information and generate the Submission Document.


	Submitting the Final Thesis  (Complete Submission)
	The Published Version with the institution’s watermark is the officially approved thesis file.
	This file is the final published version of the thesis.
	It contains the watermark of the university to certify authenticity.
	It is usually in PDF format and cannot be edited.
	Additional requirements may vary depending on the university and may be subject to change.
	If there are any questions, students should contact the institution’s staff.
	Relevant files are the documents associated with the final thesis submission. These include the Word file for editing and the PDF file for final approval.

	Status Tracking
	The Tracking Timeline + Notification feature helps both authors and mentors work together more efficiently, reducing delays in the approval process.
	Key functions include:
	Real-time Tracking - Monitor the approval status in real time through the tracking timeline.
	Feedback Review - Check comments and suggestions from advisors and committee members.
	Notifications - Receive alerts via mobile app and email whenever there is an update in status.
	Users can also receive notifications through the iThesis NexGen Mobile App,  available on both iOS and Android.
	The mobile application can be downloaded from:
	App Store (iOS)
	Google Play (Android)


	Summary of Key Processes in the iThesis System for Students
	1.
	Receive Invite Email - Access the system via the institution’s email invitation.  Prepare Microsoft Word and install the iThesis.

	2.
	Enter Required Information - Fill in essential details according to the thesis template, including committee member names.

	4.
	Plagiarism Check and Proposal Submission - Perform plagiarism detection and submit the proposal request for approval according to institutional procedures.

	3.
	Prepare Thesis Document - Draft the thesis, validate, and save it into the system.

	5.
	Complete Submission Form and Publication - Fill out the submission form  and publication details for the final approval process.


